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1 Introduccion

En este manual se describen los distintos aspectos que debe conocer el usuario sobre QuickREx y sobre
su integracion con Eclipse.

2 Conceptos basicos

QuickREXx es un plug-in para Eclipse que tiene como objetivo ayudar en la creacién y comprobacion de
expresiones regulares.

El uso de expresiones regulares dota a una aplicacion de mucha potencia, pero en ocasiones puede
llevar a la confusion. QuickREx ha sido desarrollado para ayudar a la creacién de las expresiones regulares,
permitiendo la comprobacién de las mismas sobre textos de pruebas.

QuickREXx da la posibilidad de incluir en Eclipse dos vistas, una para la creaciéon y comprobacion de
expresiones regulares y otra con una serie de expresiones regulares ya definidas que pueden ser muy Uutiles.
Ademas es capaz de trabajar con varias implementaciones de la maquina virtual java.

Desarrollado por Bastian Bergerhoff, mantiene el proyecto a través de la comunidad de SourceForge.

Puede encontrarse informacion adicional sobre el producto, en la pagina:

http://QuickREx.sourceforge.net/

3 Integracién con Eclipse

Al igual que en otros muchos casos, la integracion de QuickREx con Eclipse ofrece un entorno de trabajo
visual, cémodo y facil de usar durante los desarrollos. QuickREx da la posibilidad de afadir dos vistas y un
editor al entorno de desarrollo (Perspective).

4/21



QuickREx. Manual de usuario

Thie:

Eusko Jaurlaritzaren Informatika Elkartea
Sociedad Informatica del Gobierno Vasco

| Mumber wath 1.000-delmiter(s)

Reeguisr Expression: | [T (7:1- 500, ZH7AADR 0D \HZHT)

1000, 000,00 1 rod the s a5 & §.000U000,01
ﬁlﬂ.lﬂiﬂ.li

00,00
1,005
00

Matches decimal numbers that:
-ige )’ &5 decimall pokk and ') 5 & 1.000-celimiter
= b aactly T dacienal dighs

= may havee 2+ or “-sign in front
Dot ik v, i) SRR, s hodkahwsad 15 ot Suppodted there,

= ko ookt e @ lnading O ecxcept F they ane of the Form 0,y (e, 0100 & exchaded)

Matches matches() s s
[#] 5, et s rom 020 12

] 2] e

il
|

5/21



EJie

3.1 Vista de biblioteca de expresiones regulares (Reg. Exp. Library))

Eusko Jaurlaritzaren Informatika Elkartea
Sociedad Informatica del Gobierno Vasco

En esta vista aparecen las expresiones regulares almacenadas, con su explicacion y textos de prueba. Al
instalar el plug-in se incluyen unas cuantas expresiones regulares muy Uutiles.

[ k|
‘;;—.#R\'g‘t s J-s!?gﬂ-’;gi: ‘k R

2 B QuickREx
#-LE] Miscellaneous

&G

=17 IP-Addresses etc

%ML, HTML, ete

RE IP-pAddress wio capturing groups
RE IP-Address with capturing groups

[ Text

RE Leading whitespace

RE Trailing whitespace

RE Leading or traling whitespace

RE Lines containing 'FOO"

RE Lines containing 'FOO" and ‘BAR'

RE 'FOO' and ‘BAR' 'close o each other'
RE Complex containement

m

[] Dates

RE Yaid dates, vyyy-mm-dd
RE vald dates, dd-mm-yyyy

[} Numbers

LS I ornber waith 1. 000-dedmi
RE Positive decimal number
RE Floating point number

Para incluir esta vista en el entorno (perspectiva) activo, acceder al menu “Window-> Show View >

Other...”

| window Help

New Window

Tew Editar

Open Perspactive .

@~ @~ %-0-Q-

Customize Perspactiva,., 13 Hierarchy

Save Perspective As,,, B Image Preview
Reset Perspective o= Outine

Close Perspective I Package Explorer

Close All Perspectives

Al4Shift+Q,
Ale+Shift+Q, T

Ak4Shift+Q), P

Al+-Shift+0), O

En la ventana que aparece acceder al apartado QuickREx y hacer doble clic sobre el elemento “Reg. Exp.

Library”.
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x

|typ-e filker text

(= MyEdlipse Aax -
=+ MyEclipse Common
= MyEclipse Database
= MyEclipse Java Enterprise
= MyEdlipse Report Design
= MyEclipse Swing
= Mylyn
i=r PDE
= PDE Runtime
= QuickREx
cus| QuickREx

[+

#

®-EE

o &2 =8

Aparece una nueva pestafia en uno de los paneles de vistas inferiores, con el titulo “Reg. Exp. Library”.
Se recomienda recolocar dicha pestafa en el panel superior izquierdo, el de navegacion. Para ello pinchar sobre
la nueva pestafia y sin soltar arrastrar con el ratén hasta el panel superior izquierdo. Una vez que aparezca un

recuadro que indica la posicion deseada soltar el ratén.
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3.2 Vista de comprobacion (QuickREXx)

En esta vista se puede construir y probar las expresiones regulares.

- QuekREx B3 [: @R e DB EEHY
Reqular Expression: {[-+]?(?:(;:[|-9]1,d{o,2}(?;1,.1|d1d\,d,1*1|03,1d{2}(?!m) j Edt...

Test-Text:

=

nill

+ Evaluation Details

[ Live-evaluation Matcher.matches() is False'

Matches: 5, current is from 0 to 12
Groups: none
» Global Flags

Para incluir esta vista en el entorno activo, acceder al menu “Window-> Show View - Other...” del
mismo modo que en el caso anterior. En la ventana que aparece acceder al apartado QuickREx y hacer doble
clic sobre el elemento “QuickREX”.

& Show View x|
[tvpe Filter text
¥ (= MyEclipse AJAY -]

(= MyEclipse Comman

[+ (= MyEclipse Database

# (= MyEclipse Java Enterprise
[#- (= MyEclipse Report Design
[#-[= MyEclipse Swing

-2 Mylyn

#-{=- FDE

[# (= PDE Runtime

B QuickREx

b

! <% Reg. Exp. Library
EH-= SvN

#-(= Team

M= Vo5

—
-

ok | cancel |

Aparece una nueva pestafia en el panel de vistas inferior izquierdo, con el titulo “QuickREx”. Se
recomienda recolocar dicha pestafia en el panel de vistas inferior que esta situado en el centro. Para ello pinchar
sobre la pestafia afiadida y sin soltar arrastrar con el ratén hasta el panel central. Una vez que aparezca un
recuadro que indica la posicion deseada soltar el ratén.
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4 Utilidad Practica

QuickREXx es una herramienta muy potente para la creacién y prueba de expresiones regulares.

Trabaja con las librerias de uso de expresiones regulares mas comunmente utilizadas en el mundo Java.
e JDK Regular Expressions (disponible desde la version 1.4 del JDK)

e Jakarta ORO Perl-style Regular Expressions (ORO-Version 2.0.8 soporta Perl 5.003 Regular
Expressions)

e Jakarta ORO Awk-style Regular Expressions (ORO-Version 2.0.8)
e JRegex Regular Expressions (La version 1.2_01, soporta Perl 5.6 Regular Expressions)
e Jakarta-Regexp Regular Expressions (Version 1.4)

Para cada una de estas librerias es posible configurar los flags de uso desde la vista que ofrece el plug-in
QuickREXx o bien pueden ser activados en linea utilizando las opciones de la misma expresion regular, siempre,
claro esta, que la implementacion dada lo soporte.

En los siguientes puntos se explicara en detalle toda la funcionalidad que ofrece el plug-in.
4.1 Biblioteca de expresiones regulares

La vista con la biblioteca de expresiones regulares (Reg. Exp. Library) se afiadié en la version 3 del plug-
in. Es una herramienta que permite almacenar, organizar y buscar expresiones regulares de uso comun.

Pueden organizarse segun temas, por ejemplo: literales, fechas, numéricas, etc. Ademas la vista ofrece la
posibilidad de realizar busquedas a través de las expresiones almacenadas.

4.1.1. Estructura de la biblioteca

La biblioteca de expresiones regulares contiene ‘Libros’ los cuales contienen ‘Categorias’ donde se
almacenan las ‘Definiciones de expresiones regulares’.

Con la instalacion del plug-in se incluye un libro por defecto llamado ‘QuickREX’. Este libro es de sélo
lectura, no se puede afiadir, modificar o borrar los elementos del mismo.

I gl

= Reg. Exp. Library &3 Gf{} | ﬁ[ =

=] l,‘il QUItkRE:  sa———""" Libro
| Miscellaneous

5 a—— Categoria
[E] %ML, HTML, etc
[Z| IP-Addresses ekc

RE Mumber with 1.000-delirmiter(s)
RE Paositive decimal number Y
RE Floating point number sg——"" Definicidn
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La biblioteca que viene por defecto con el plug-in puede utilizarse como punto de partida para crear
nuevas expresiones regulares. Sus elementos: categorias y definiciones, no pueden ser modificados utilizando
los accesos directos que ofrece el plug-in, pero dichos elementos son definidos en un fichero xml, por tanto
puede ser adaptado a las necesidades de uno mismo. En cualquier caso, como el plug-in ofrece la posibilidad
de crear nuevos libros, no es necesario modificar el que viene por defecto.

La siguiente figura muestra el contenido de la biblioteca que se instala por defecto con el plug-in:

m

B4

RE 1SBN-Numbers

RE Mastercard-numbers

XML, HTML, etc

RE Tags (1)

RE Tags (2)

RE Tags (3)

RE Empty tags

IP-Addresses etc

RE IP-Address wfo capturing groups
RE IP-Address with capturing groups
Text

RE Leading whitespace

RE Trailing whitespace

RE Leading or trailing whitespace

RE Lines containing 'FOO"

RE Lines containing 'FOO" and 'BAR"

RE 'FOO" and 'BAR' 'close to each other’

RE Complex containement
Dates

RE valid dates, vyyy-mm-dd
RE Valid dates, dd-mm-yyyy

1-L7] Numbers

RE Mumber with 1,000-delimiter(s)
RE Positive decimal number
RE Floating point number

4.1.3. Creacion y gestion de libros

Para afiadir un nuevo libro a la biblioteca desde el que gestionar nuestras propias expresiones regulares,

acceder al menu: “File> New - Other...”.
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5 Package
(& Class
&4 Interface
fp Source Folder
| Folder
* File:
A’ Applet
H HTML (Advanced Templates)
7 J5P (Advanced Templates)
HI XHTML {Advanced Templates)
&5 Serviet

Alc+Shift+h ¥
Close Ctrl+w
Close Al Chri-Shift-+W
B Ctrf4+5
e
Wsave Chrl4-Shift+ S
Hewvert
Fé
F5
3
..T'nr« 47
Switch Workspace 3
2y Import...
15 Expott...
Properbies AlbEErnter

1 produccion.log4j.properties [LOPDY...]
2 preproduccion,log4f. properties [LOP,..]
3 desarrollo.log4f.properties [LOPD/...]
4 envioinspeccion. fsp [LOPD/webfisp]
Exit

| & EJB3 Enkity Bean

[ EJB3 Message Driven Bean
X XML (Advanced Templates)
X ¥ML (Basic Templates)

) UML Model Repositary

= L7 numbers
RE Number with 1.000-delmiter{s)
RE Pogitive decimal number

[ Exampla...
‘ Cither...

En la ventana que aparece buscar el apartado ‘QuickREX’ y hacer doble clic sobre ‘Regular Expression

Book...’, tal como se muestra en la figura:
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_Ioix]

Select a wizard L <5
Create a file holding & book in your QuickREx Regular Expression Library I

Wizards:
Jtvpe filter text

= General :‘
== Cvs

= Eclipse Modeling Framework

= Example EMF Model Creation Wizards
= Java

= Java Emitter Templates

= MyEdipse

(= Mybyn

(= Plug-in Development

= = QuickFex

EEEEREEEES

L= SN
1= User Assistance

B-m

Led

[ show All Wizards,

7) < Back I hexk > I Einish l Cancel |

En la ventana que aparece, indicar el fichero xml dénde se almacenara la informacion del libro y el
nombre que se desea que aparezca en la vista de biblioteca.

€ ~lofxj
Regular Expression Book

This wizard creates a file holding a book in your QuickREx Reqular
Expression Library

File path: | elplugins|de. babe. eclipse. plugins, QuickREx_3.5.0\MiLibro.coml | Browse. .,
Book name: | MiLibro|

) <gack | weos |[TEnish | comce |

Por ultimo pulsar ‘Finish’. Debera aparecer el libro creado en la vista de biblioteca, como muestra la
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siguiente figura:

& B QuickREx

e

A diferencia del libro por defecto que se incluye en la aplicacién, cualquier otro que creemos nostros
mismos podra gestionarse desde la vista de biblioteca incluida en el plug-in.

41.4. Gestionando un libro

Para crear una categoria pinchar sobre el libro en el que se va a crear, pulsar el boton derecho del raton y
en el menu contextual que aparece, seleccionar ‘Add catgegory...’, tal como muestra la figura.

En la ventana que aparece, indicar el nombre de la categoria y pulsar ‘OK’.

& Enter category-name ] : ‘E_I

Please enter a name for the category

| alfanuméricos]|

OK Cancel

Debera aparecer en la vista tal como muestra la figura:
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H ﬂ: QuickREx
= MiLibro

Desde el menu contextual que aparece cuando esta seleccionado el libro se puede:
e Afadir categoria. (Tal como se acaba de explicar).
e Cambiar el nombre del libro.
e Cambiar la ruta del fichero xml que define el libro.
[ ]

Borrar el libro. Esta accion eliminara todos los elementos (categorias y expresiones regulares)
incluidos en el libro.

4.1.5. Almacenando una expresion regular

Para crear una expresion regular pinchar sobre la categoria dentro de la que se quiere crear, pulsar el

botén derecho del ratéon y en el menu contextual que aparece, seleccionar ‘Add Reg. Exp. entry...’, tal como
muestra la figura.

[ X
= Reg, Exp. Library £3 g | 4 Y]
® E.1| QuickREx
E-E miLibro

Add Req. Exp. entry...

Rename category...

Delete category

En la ventana que aparece, indicar el nombre que se le quiere dar a la expresion regular y pulsar ‘OK’.

& Enter title x|

Please enter a title for the entry
| MIF|

i oK I Cancel

Debera mostrarse en la vista tal como indica la figura:
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[
|

:-.-'. * Req. Exp. Library EE

#- B QuickREx
=@ MiLibro
=4[] Alfanuméricos

RE

Ademas al crear la definicién de una expresion regular se abre en la zona de edicién, la ventana de
edicion de la expresion regular que queremos definir. La ventana de edicidon de expresiones regulares se
explicara en el siguiente punto de este mismo manual.

Desde el menu contextual que aparece cuando esta seleccionada una categoria se puede:
e Afadir expresion regular. (Tal como se acaba de explicar).
e Afadir categoria. Se posicionara inmediatamente después de la categoria seleccionada.
e Cambiar el nombre dado a la categoria.
e Eliminar la categoria seleccionada. Esta accion eliminara todas las definiciones de expresiones
regulares incluidas dentro de la categoria.

4.1.6. Trabajando con expresiones requlares

Cuando se pincha con el ratéon en una expresion regular creada en un libro que no sea el que viene por
defecto con el plugin, aparece el siguiente menu contextual:

=4[] Alfanuméricos

| Tags HI Add Req. Exp. enkry...
| TagsHT  Edit...

Delete. .,
Use in QuickRE:x-Yiew..,

Ademas de dar la posibilidad de afadir una nueva expresiéon regular, este menu nos permite con la
expresion regular seleccionada:
o Editar (Edit...): Muestra la informacién existente en el panel de edicién de QuickREx y permite
modificarla.
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& MyEchpse Java Endenprise - - Eclipse Platiorm ...I.n.lﬁl
Ble Bt Mevigale Segch Broject MyEdpse Bun Windew Help
Y= | [ R R T R T . B .Sy e S 5 [ | rayecigse Jav... S Team Synhe...
[ + S » JE» OO 73 P O . = | - Y . . &' % deate
2 pao [ Ts Hera [ Mt [ hog. 51T O/ f soktudant (1] CccosBiova |1 Crowsokckuicen [ e L e = O)(5= cutre 3 5 =0
- N R [rar =2
= B quanex Regu Expeesson: [VHENAZST] o i
- E"":: 1ZHEATES
= L Al arwgrdrico PLEEATE
LN Tost Test: 12HEAR
<1 Tags HTML Cabecsrs ..f.l
(50 Tags HIML Clmepo
Vabdacin de T,
P e valeds ol digho de cortrol |
Description:
Ll
Sounce!
Ll

Detsks |
£ Protie | Tasks [ @ Webior | Conscl | 5 Server | 1) Hstory | 4 Search 2o

D =B

&g EEE
=

| _f;l o {

Jit® | | |

Eliminar (Delete...): Elimina la expresion regular de la categoria en la que se incluyé.
Utilizar en la vista de pruebas de QuickREx (Use in QuickREx-View...): Traslada la expresion
regular y el texto de prueba a la vista en la que se puede probar el correcto funcionamiento de la

expresion regular.
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Be [t Hedgste Seach Project Myfdpse Bun Window belp
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| -0~ | EFG- |5 & = i Cla &' ® e
B Pock | 1 x| M [ e, 33 ) B O quien 52 N 00
hne 3
. i a1 ek aeodale.
B muteo
A arnmdios
nE MF
Tasgs HTML Cabiacars
Tags ML Cuespo
15 Prckie | 2) Tadkes | @ Wb b | B ol | 866 Server | (1 ristory | ' Soarch [ -JpkMAEL.
|t Rk et et A ol P Beinat] L L T el ekl
| B !
Ry Expressin: [IHEHi-T-c]
TestTht:
= Evahsation Details OrH e 0
B Live-ervabusion Dmmmcm;nw' B X =
- o =il ety | vk
B image prevewy 3\ L Seigpets | O rastches: [Em] ] v cormt wemonse
3 S
PIXCYok- Tl N o |
= Glabal Flags
ous can configue the okl flags used for the ciaaton of the requisr-expression compders hare. The flags se
sk, L. thesy s sarved s stats when the view b5 chosed
XK Flags [ Corcrical equivaience [ Case rsenstive [ Comments [ Dotat Br
ORO Perl Flags [ case rserates O estended Ormidne [ Sngeire
R ok Flags: [ Case rsernieve
| eges Flags: [ case rsenstee O e [m [ O soneee spaces O
- _'IJJ Jsbarta-Fegenp Flags: [ Case nsersive O e . i 2)

4.1.7. Busqueda de expresiones requlares en la biblioteca

Se pueden buscar expresiones regulares previamente almacenadas en cualquiera de los libros de la

biblioteca utilizando el botdn del menu rapido: ﬂ Se obtiene la siguiente ventana de busqueda:

&= Search Reg. Exp. Library enl &5 x|

Search for; |
Searchin: [ Tile
" Reg. Exp.
[~ Test bext
™ Description
r~ Sarce

oxlmd|

En ella se puede buscar en el titulo, la expresién regular, el texto de prueba, la descripcién y el campo
fuentes. La operacion de busqueda se realizara sobre todos los libros de la biblioteca.

4.2 Vista de prueba de las expresiones regulares

La vista de pruebas de las expresiones regulares (QuickREx view) permite comprobar que las
expresiones que definimos se ajustan a lo esperado. Para ello, comprueba al vuelo, si la opcion correspondiente
esta activada, el texto que se introduce en el campo: Test-text.

19/21



m Eusko Jaurlaritzaren Informatika Elkartea
l Sociedad Informatica del Gobierno Vasco

En la siguiente figura se muestra la apariencia de la vista y se describen brevemente los elementos de la

misma:

4.21.

= Global Flags

You can configure the global flags used for the creation of the regular-exprestion compders here, The flags are 'sticky’, |8, they are saved &2 state when the view i
closed,

DK Flags: O carcnical equivalence [J Case nsenstive [ Comments [ Dotal [ mubiine [ Unicode case [ Ui ines 7
(ORO Perl Flags: O Case insersitive [ Extendsd O mtitne [ Singleline

(ORO Ak Flags: O Case insensitive

Regex Flags: [ case insensitive O rultiine O octat O 1gnore Spaces [ unicode [ =ML Schema

Jakarta-Regexp Flags: [ Case insersitive [ rudtiine

SIN

No ok

8.

Botones para navegar hacia delante y atras entre las partes del texto de prueba que se adaptan a
la expresién regular.

Si esta marcado, valida automaticamente el texto de pruebas.

Si no esta marcada la opcidn ‘Live-evaluation’ sirve para provocar la validacién del texto de
pruebas.

Campo para editar la expresion regular.

Campo para modificar el texto de pruebas.

Botdn que lleva al asistente de edicién de expresiones regulares.

Ademas de poder activar las opciones del motor de expresiones regulares, en linea, en la misma
expresion regular. También se pueden utilizar las opciones de ‘Global Flags’ para hacerlo de una
manera mas clara y sencilla.

Como se dijo anteriormente en este manual, QuickREx ofrece la posibilidad de usar los motores
de expresiones regulares mas comunmente utilizados. Asi pues, también se pueden activar las
opciones globales en funciéon de la implementacion utilizada (JDK, ORO Perl, ORO Awk, JRegex,
Yakarta Regexp).

Botones para seleccionar la implementacion con la que se probara la expresion regular.

Asistente en linea

Al igual que en otros editores de Eclipse, en el campo de ediciéon de expresiones regulares del plug-in
QuickREXx puede utilizarse un asistente en linea que ayude a completar la expresion. Para conseguir una lista de
propuestas que ofrece QuickREXx, hay que pulsar ‘ctrl.+barra espaciadora’ mientras se edita la expresién en el
campo de edicion. Se abrira un asistente, tal como muestra la siguiente figura:
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Regular Expression: ;'| p
Test-Text: In Unicode-block U ﬂEp{an}- - acharacter in the block U —

Uppercase Letter (Unicode) block names are defined in
Currency symbol (Unicode) kbp: ffwweve. unicode, orgfPublicf3. 0-UpdatefBlocks-3.t
Lower-case alphabetic (US-ASCIT) Spaces removed such that ‘Basic Latin' is to be
Upper-case alphabetic (US-85CTT) used as \p{InBasicLating etc.)

4 US-ASCIH
Alphabetic (US-AS5CII)

« Evaluation Details Digit, (LI5-A5CIT)
Alphanumeric (US-ASCII)
[ Live-evahuation E Punchuation (US-ASCIT)
Visible (US-ASCII)
Matches: I Printable (LIS-ASCIT) hd|

Groups: |I'r_-.- VoS | | ek I

Conforme se van seleccionando las diferentes propuestas, en el panel de la derecha va cambiando la
descripciéon de la propuesta. Pulsando doble clic sobre la propuesta, es trasladada al campo de edicion,
completando nuestra expresion regular. Dada la complejidad de las expresiones regulares, no se puede afirmar

que se muestran todas las propuestas posibles, pero si unas cuantas que ayudan a la creacion de la expresion
regular.
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